
ZHT-19 

April 2026 

 
 

How To: 
Installing Offline Versions of Mx 

Software for Analysis-Only 

Introduction 

This document details the process for installing an offline version of Mx for offline analysis. There are 3 

general steps in this process:  

1. Downloading the Mx software installer executable 

2. Running the installer 

3. Licensing the software 

Pay close attention to the Licensing process as not performing it correctly, will result in a license that 

will not activate or will de-activate earlier than expected.  

At the end of this document is also a section that details how the Windows’ display setting should be set 

for Mx to be properly rendered.  

System Requirements: 

• Window 10, 64-bit supports Mx version 7, 8, 9, and newer 

• Window 11, 64-bit supports Mx version 9.3 and newer 

• Intel Multi-Core or Multi-Processor (4 Core/Processor Minimum)  

• 16 GB RAM or more; 32 GB recommended  

• Dedicated graphics card supporting OpenGL with 256 MB RAM (recommended)  

• OpenGL 3 or later  

 

Unsupported Operating Systems/environments  

• Windows XP & earlier, 8, and 8.1, Windows Server  

• Windows 11 is not yet officially supported as of Mx version 9.2.  

• Any non-Windows operating systems (i.e. macOS, Linux). For systems not running Windows 7 or 

10, there has been some success by setting up a dual-boot option running Windows 7 or 10. 

• Virtual machines are not supported.  
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Procedure Overview 

Here is a quick overview of the procedure for installing an offline (analysis-only) instance of Mx. The rest 

of the document goes into much more detail of the process from getting the installer through licensing if 

you need clarification. Pay close attention to anything marked IMPORTANT as making an incorrect 

selection can cause Mx not to function properly. 

1. Get the Installer 

1.1. Get the installer file from:  

• The Zygo website 

• Direct link emailed to you 

• From your Zygo instrument 

 

1.2. Place the installer in C:\MxInstall. 

 

2. Run the installer 

 

2.1. Accept the End User License Agreement. 

 

2.2. IMPORTANT: Select “Software Only” as the 

setup type. 

 

 

3. Licensing Mx 

3.1. Open Mx and go to Help > Licenses to start 

the Licensing Wizard. 

 

3.2. For the Lock Type select Ethernet. 

 

3.3. IMPORTANT: Select a static MAC address 

This is an extremely important step. If you do 

not know whether a given MAC address is 

static or dynamic, review the more detailed 

step in Section 3: Licensing Mx or contact your 

Zygo representative. Failure to select a static 

MAC will lead to license issues in the future.  

 

 

3.4. Request a License 

Send Mx version & Hardware ID (not the 

MAC address) to your Zygo contact. 

 

 

3.5. IMPORTANT: Enter your license information 

(key, start & end dates) exactly as they in the 

License document that is sent to you.  
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Section 1: Obtaining the Mx Software Installer 

The installer for Mx software can acquired via a few methods and each method is detailed further below:  

1. Downloaded from the Zygo website. 

2. A secure link sent directly to you by your Zygo contact typically through Amefex which is our secure 

file sharing platform.  

3. Copy the exe from your instrument PC. 

Which Mx Version to Use 

Generally, it is advised that if you have an instrument at your facility and you will be moving 

applications/settings files between your computer and the instrument that you match software versions 

between the tool and offline PCs for consistency. If you are just using the offline version of Mx for 

analysis, then it is recommended to use a more recent version of Mx as there are new features & bug fixes 

to improve your experience. 

Finding Mx Version # 

To find out what version of Mx is being used on your instrument, open the Mx software and go to the 

“Help” menu then select “About”. Note: in older versions of Mx, the version is listed as the Assembly 

number (Example: 7.6.0.4) within the Version Information box. 

 

            

 

  

https://www.zygo.com/support/metrology-software/mx-software
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Method 1: Download Installer from 

the Zygo website 

1. To download the installer from the Zygo 

website, you will first need to create an 

account on the website. This is a one-time 

process and then you can use the account to 

download the Mx installers in the future or 

to download manuals, spec sheets, and 

other information from the website.  

 

Typical turn-around time for approving 

accounts is about 1-2 business days so if 

you need to access something quickly, 

contact your Zygo representative or email 

zygo.support@ametek.com to help get you 

what you need quickly.  

 

To create an account: 

1.1. Click on the “Login” button in the top right 

corner of the website and a popup screen 

will be displayed 

 

 
 

1.2.  Click on the Register button 

 

 
 

 

1.3.  Fill out all required items in the Registration 

form then click “Sign Up”. Accounts are 

typically approved within 1-2 business days 

but if you need the installer is urgent than 

contact your Zygo representative or email 

zygo.support@ametek.com.   

 

IMPORTANT: When signing up for an 

account, use your business email address as 

accounts are not approved for email 

addresses with generic domains like 

@gmail.com or @yahoo.com.  

 

2. Once you have an account setup, click on 

the “Login” button, and provide your 

username & password to log in 

 

3. Go to the Mx Software download page and 

click on the software version that you want 

to download. The download should then 

start automatically. 

 

4. After you download the installer zip file, 

move the zip file to C:\MxInstall (note: 

create the folder if it does not already exist) 

then right-click on the zip file to unzip the 

file. 

 

 

 

  

https://www.zygo.com/
mailto:zygo.support@ametek.com
mailto:zygo.support@ametek.com
https://www.zygo.com/support/metrology-software/mx-software
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Method 2: Download Installer from 

a secure Amefex link 

You might receive a link from your Zygo contact 

to download the Mx installer using our secure 

file sharing platform Amefex. If you do, there’s 

how to download it from that link.  

1. Click the link from their email to access the 

download page 

 

2. You will be prompted to authorize your 

access for the file. Enter your business email 

address then click Authorize. If you have an 

Amefex account already, you will then enter 

in your password.  

 

If you don’t already have an account in this 

system, when you do this, it will send you an 

email to validate your email address. 

 

 

 

3. Once you are logged in, you should see the 

secure message that looks like below with 

the link to download the Mx installer exe 

file and possibly another link to download a 

copy of these instructions. You can either 

click the exe link to download just the exe or 

you can click the Zipped Archive button to 

download all files.  

 

 

 

4. After you download the installer file, move 

the exe file to C:\MxInstall (note: create the 

folder if it does not already exist). If you 

download the Zipped Archive, then you will 

need to unzip that file before placing the 

exe in C:\MxInstall.  

 

Method 3: Getting the Installer from 

your Instrument PC 

If it is easier for you to get the installer file from 

your instrument, you can do that as well. To get 

it from your instrument PC: 

1. Navigate to C:\MxInstall on the instrument 

PC. Older instrument did not have this 

standard folder for the installer so if you do 

not see this folder, then obtain the installer 

through one of the other methods. 

 

2. Copy the installer to USB drive or use some 

other transfer method. 

 

3. Place the installer in C:\MxInstall on the 

computer that you want to install Mx on.  
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Section 2: Installing Mx for Offline Analysis 

IMPORTANT NOTE: You may need to disable any active Antivirus software to install Mx. 

 

1. Double click the Mx installer exe located 

inside the C:\MxInstall (move the installer 

there if you have not already) file to launch 

the program. If there are any pending 

required items to be installed, click Install.  

 

 
 

2. Click Next to start the installation of Mx 

 

 
 

 

 

 

 

 

 

3. Read the End User License Agreement and 

select the radio button that you accept the 

terms of the license agreement then click 

Next. 

 

 

 

4. At this point you will be prompted to accept 

the installation of Python (the Python 

version will depend on the Mx version). Click 

yes to continue.  

 

 
  



Zygo How-To Installing an Offline Version of Mx for Analysis 

Section 2: Installing Mx 

 

6 | P a g e  

 

5. IMPORTANT: At this point you will be 

prompted on the type of software setup you 

would like to install. It is important that you 

select the Software Only option before 

clicking the next button.  

 

DO NOT select the Instrument Support 

option as it will then start asking you to 

select hardware configurations like motion, 

camera, etc that do not apply to offline Mx 

installations.  

 

 

 

6. The next prompt pertains to the default 

Installation path. It is set to C:\Program 

Files\Zygo\Mx and should remain the 

default path. Click Next. 

 

 
 

7. Click Next and the program will begin to 

install itself on your PC.  Do not close any 

windows until the installation process is 

complete.  

 

 
 

 

8. After the installation is complete, click 

Finish. 
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Section 3: Licensing Mx Software 

The last step before being able to use your offline version of Mx software is to license the software 

package. This will link your installed version of the software to a MAC address associated with your PC and 

generate a Hardware ID. The Hardware ID (not the MAC address) is what you will send to your Zygo 

contact for them to get you a license.   

NOTE: each installation of Mx will have its own unique hardware ID and thus its own unique license so 

each user will need to get their own license generated. 

 

Note on Docking Stations 

For the next steps, if you are installing Mx on a laptop that is in a docking station, it is recommended that 

you disconnect the laptop from the docking station before proceeding. If you are using a laptop that is in 

a docking station, then the list of MAC addresses to select from in a few steps might contain a MAC 

address for a device that is in the docking station and not in the laptop. If you were to remove the laptop 

from the docking station, then that MAC address is no longer able to be seen by Mx and the licenses 

would become invalid.  After the Licensing Wizard is complete, it is OK to continue using the laptop in the 

docking station like you were. 

 

1. Launch Mx and go the Help menu then 

select the Licenses options. This will launch 

the Licensing Wizard.  

 
2. Select Next on the home screen of the 

Licensing Wizard to start the licensing 

process. 

 
 

3. If you are prompted to select a Lock Type of 

Ethernet or Sentinel, select Ethernet unless 

you have purchased a Sentinel USB dongle 

from Zygo. 
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4.  IMPORTANT: follow this step closely 

This step is where you select the MAC address that will be used to create the Hardware ID that is 

used for licensing.  

 

NOTE: the MAC address is different from the Hardware ID, the MAC address is not what you will send 

to your Zygo contact for them to generate the license, but it is used to create the Hardware ID that 

you will send to your Zygo contact. The Hardware ID that you will need to get a license generated will 

be found in a couple more steps. 

 

Depending on the computer that you are installing Mx on, there might be multiple MAC addresses 

that you can choose from, and it is important that you select the correct one as selecting an incorrect 

one can lead to the license information becoming invalid.  

 

The correct MAC address will be for a device that will have a static or permanent MAC address and 

an incorrect MAC address would be for a device that has a dynamic or non-permanent MAC address.  

 

 

 

To determine the correct one to use, click on each of the MAC addresses in the white box and read 

the description that is displayed for each of them to the right. If the description starts with it being an 

Ethernet and Wi-Fi adapter, then it is most likely a static MAC address & the one that you will want to 

select. If anywhere in the description it says “Virtual” or “Bluetooth” then that will be a dynamic MAC 

address and one that you will not want to select.  

 

Below are some example MAC address descriptions and which are Static/Permanent vs 

Dynamic/Non-Permanent.  
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If there are multiple MAC addresses listed and you are not sure which to select, select each MAC 

address & take a screenshot of the “Select MAC Address” window (like you see below) then send 

them to you Zygo contact (i.e. if there are 3 MAC addresses listed, then you should send 3 

screenshots with the different descriptions captured). They can then provide feedback as to which is 

the best one to select. 
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5. Click Finish to complete the Licensing Wizard. The next step is where you will see your Hardware ID.  

 

 
 

6. IMPORTANT 

 

At this point you should see the License Keys window (if you do not, go back to “Help” > “Licenses” 

and it should open the License Keys window if the Licensing Wizard has been successfully completed) 

which looks like the below image. The License Keys window has Hardware ID & Mx Version that are 

needed to generate a license.  
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7. Requesting a License 

There are 2 ways that you can request an Mx license: email or the License Request form on the 

website 

 

7.1. Method 1: Request Via Email 

To request a license via email, take a screenshot of the License Keys window (it has both the 

Hardware ID and Mx Version) like you see above, ensuring that the text is large enough so that it 

is still able to be read, and email that to your Zygo contact (Account Manager, Applications 

Engineer, or Field Service Engineer). If none of those emails are available, please email the 

screenshot to the Zygo Support email: zygo.support@ametek.com.   

 

7.2. Method 2: Request Via Website Form 

To request an offline Mx license via the website, go to the Mx License Request Form. Fill out all 

the required fields including the Hardware ID and the Mx version you have installed (both are 

found in the License Keys window). Note: the email address you use in this form is the email 

address that your license information will be sent to. Please use your business email address as 

licenses are not sent to email addresses with generic domains like @gmail.com or @yahoo.com.  

 

 

 

After you submit the form, you should receive your license information within 1-2 business days. 

If you do not receive your license information by then, contact zygo.support@ametek.com or 

your Zygo Representative. 

  

mailto:zygo.support@ametek.com
https://www.zygo.com/support/metrology-software/mx-license-request
mailto:zygo.support@ametek.com
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8. Once you receive the PDF containing your license information, you will need to enter the license Key 

and Start & Expiration dates exactly as they appear in the PDF into the License Keys window (“Help” 

> “Licenses”). After all information has been entered, hit the Enter key and if all information has been 

entered correctly, the box at the end of each licensed row in the Valid column should be checked.  

 

If the check box is not checked for a given item after you hit enter that should be licensed: 

-Check that the Hardware ID in the License Keys window matches the Hardware ID listed in the 

License information PDF 

- Check that all the start & end dates and key match exactly what is in the License information PDF 

 

 
 

9. Mx should now be fully licensed & ready to use. To start out, go to the Load Application button or 

File > Load Application to load the application you want to use to analyze your data. Typically, you 

would use the Micro.appx if you are looking at data from a Zygo optical profiler (Nexview, Newview, 

or Zegage), Form.appx for a standard Zygo laser interferometer (Verifire or Dynafiz), or the 

MST.appx application if using a Zygo MST.  
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Appendix: Windows’ Display Settings 

It is important that you have your Windows Display Settings set in a particular way so that Mx will be 

displayed properly. If the settings are not set correctly then Mx can fail to display parts of the user 

interface. Below are the steps to set your Windows Display Settings properly for Windows 10 (Windows 7 

uses the same settings though how certain things are named might be slightly different). 

Note: the exact name of some of the settings below or their exact location might be slightly different 

between exact versions of Windows, but they should be similarly named & located. 

1. Display Settings 

1.1. Go to the Display Settings window by right-clicking on the Desktop and going to Display 

Settings 

 

 
 

1.2. Set the “Size of text, apps, and other items” to 100% 

 

 
 

1.3. Set the “Display Resolution” to 1920x1080 

Note: this may be under “Advanced” settings 
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2. Mx properties 

2.1. Right-click on the Mx short-cut icon and go to Properties 

 

 
 

2.2. Under the Compatibility tab go to Change high DPI settings then ensure the Override high 

DPI scaling behavior checkbox is unchecked.  
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